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Hand command (Tool menu)
Select this tool to enable the Hand cursor in the document window.    Using the hand you can easily show 
other parts of the same page in the viewing window using the mouse.

Moving the Page
· Grab and drag the current page to move to a different part of the document.    Only the current 

document viewing area is updated using the Hand tool; the Zoom level does not change.

Shortcut
Keys: CTRL+H



Zoom In command (Tool menu)
Select this tool to enable the Zoom-In cursor in the document window.    You can then Zoom In on the 
document up to 3,000 percent using the mouse.    This shows more detail and less of the document in the 
viewing window.

Zooming In
· Drag a zoom region around a selected area which will be redrawn and shown in more detail.    The 

RichImage Mini-Viewer will zoom to show the rectangle that you define.    The smaller the zoom 
rectangle, the more you will zoom in.

or
· Click on an area of the document, a zoom point, to be the center of the zoomed in window.    The 

zoom level will change to the next larger standard zoom level.    Note: A zoom point will not zoom 
more that 1,600 percent.

Tip: When the click zoom point reaches the highest level, you can easily move around the document 
in great detail by clicking the mouse button along the edges of the visible page.

Shortcut
Key: +

See also

Using Zoom

Zoom Out command



Zoom Out command (Tool menu)
Select this tool to enable the Zoom-Out cursor in the document window.    You can then Zoom Out of the 
document up to 7 percent using the mouse.    This shows less detail and more of the document in the 
viewing window.

Zooming Out
· Drag a negative zoom region around a selected area which will be redrawn and shown in less detail.   

The smaller the zoom rectangle, the more you zoom out.
or
· Click on an area of the document, a negative zoom point, to be the center of the zoomed out window. 

The zoom level will change to half the current level.

Shortcut
Key: -

See also

Using Zoom

Zoom In command



First Page VCR command (View menu)
Use this command to jump to the First page of a the document.    This is used to quickly get back to the 
beginning pages in a long document.    This button is unavailable if the first page is already visible.

The current page is displayed in the Status bar Page area.

Shortcut
Keys: Ctrl+Home



Previous Page command (View menu)
Use this command to jump to the Previous page in the document.    This moves the current viewing 
window to show the previous page.    This button is unavailable if you are already on the first page.

The current page is displayed in the Status bar Page area.

Shortcut
Keys: Ctrl+PgUp



Next Page command (View menu)
Use this command to Jump to the Next page in the document.    This moves the current viewing window to
show the next page.    This button is unavailable if you are already on the last page.

The current page is displayed in the Status bar Page area.

Shortcut
Keys: Ctrl+PgDn



Last Page command (View menu)
Use this command to Jump to the Last page of the document.    This is used to quickly see the last pages 
in a long document.    This button is unavailable if the last page is already visible.

The current page is displayed in the Status bar Page area.

Shortcut
Keys: Ctrl+End



One Page command (View menu)
Use this command to display the RichImage document in a One Page View mode.    Use the One Page 
View mode for viewing one page at a time.    This is the quickest mode for moving through a document 
and changing zoom levels, since screen redrawing is kept to a minimum.

Shortcut
Keys: CTRL+1

See also

Using Page Views



Two Page command (View menu)
Use this command to display the RichImage document in a Two Page View mode.    Use Two Page Views
to show pages side by side.    Use the horizontal scroll bar to move the current view to show other pages 
in the document.    Documents that have specific formatting for Two Page Views (i.e. books) are displayed
best in this mode and navigating is the most intuitive.

Shortcut
Keys: CTRL+2

See also

Using Page Views



Three Page command (View menu)
Use this command to display the RichImage document in a Three Page View mode.    This shows the 
maximum number of horizontal pages in the main viewing window.    Use the horizontal scroll bar to move 
the current view to show other pages in the document.

Shortcut
Keys: CTRL+3

See also

Using Page Views



Open command (File menu)
Use this command or button to open an existing document in a new window.        The RichImage Mini-
Viewer displays the File Open dialog box, in which you can locate and open the desired file.    You can 
open multiple documents at once.    Use the Window menu 1, 2, ... command to switch among the multiple
open documents.

Select an option for more help:

Shortcut
Keys: CTRL+O



File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the List 
Files of Type box.



List Files of Type
Select the type of file to list in the List Files of Type box:

RCH is the default extension for RichImage files.
*.* is used if your RichImage file does not have the default RCH extension.



Drives
Select the drive that has the RichImage file that you want to open.



Directories
Select the directory that has the RichImage file that you want to open.



Close command (File menu)
Use this command to close all windows containing the active document.

Shortcut

Mouse:
Double-click the Close icon on the documents window.

Keys: CTRL+F4



Extract Files command (File menu)
Use the extract files command to break an embeded document into two components: the original 
RichImage document, and the mini-viewer that is attached to it.    You will be prompted to enter the name 
and directory of the files to create.

Note:    This command is disabled if you are not viewing en embedded mini-viewer document.



Create Viewer command (File menu)
Use the create viewer command to combine the active document to the mini viewer, to create an 
embedded viewer document.    You will be prompted to enter the name and directory of the document to 
create.



Save As dialog box
Use this dialog box combine or extract the document and mini-viewer.    The RichImage Mini-Viewer 
displays the Save As dialog box so you can specify the name and location of the file you are about to 
save.

Select an option for more help:



File Name
Enter a filename to save as the document.    A filename can contain up to eight characters and an 
extension of up to three characters.    The dimmed files are existing RichImage documents.    The 
RichImage Mini-Viewer adds the extension you specify in the Save File as Type box.



Save File as Type
Select the type of file to save in the Save File as Type box:

RCH is the default extension for RichImage files.
EXE is used for embedded mini-viewer documents.



Drives
Select the drive in which you want to store the document.



Directories
Select the directory in which you want to store the document.



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Print command (File menu)
Use this command to print a document.    This command presents a print dialog box, where you may 
specify how the document should be printed.

Select an option for more help:

Shortcut
Keys: CTRL+P



Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.



Pages (Print Range)
Print the range of pages you specify in the From and To boxes.



Selection (Print Range)
Print the currently selected text.



All (Print Range)
Print the entire document.



Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.



Copies
Enter the number of copies of the document to print.



Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress dialog box
The Printing dialog box is shown during the time that the RichImage Mini-Viewer is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a print setup 
dialog box, where you specify the destination printer and its connection.

Select an option for more help:

See also
Print command 



Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option and 
select one of the current installed printers shown in the box.    You install printers and configure ports 
using the Windows Control Panel. 



Portrait orientation
Select portrait orientation if you are printing a page that is taller than it is wide when you view the text 
upright.



Landscape orientation
Select landscape orientation if you are printing a page that is wider than it is tall when you view the text 
upright.



Paper Size
Select the size of paper that the document is to be printed on.



Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.



Options
Displays a dialog box where you can make additional choices about printing, specific to the type of printer
you have selected.



Exit command (File menu)
Use this command to end the Mini-Viewer session.    You can also use the Close command on the 
application Control menu.

Shortcuts

Mouse:
Double-click the application's Control menu button.

Keys: ALT+F4



Status bar command (View menu)
Use this command to display or hide the status bar.    A check mark appears next to the menu item when 
the status bar is displayed.

Use the status bar to:
· Show the current and total number of pages.

See also
Using the Status bar



Using the Status bar
The status bar is displayed at the bottom of the RichImage Mini-Viewer window.

The status bar contains the following

Page area
Located along the bottom right of the RichImage Mini-Viewer, the current page and the total number of 
pages in the document are displayed in this area.

See also
Context Help command



New Window command (Window menu)
Use this command to open a new window with the same contents as the active window.    You can open 
multiple document windows to display different parts or views of a document at the same time.    If you 
change the contents in one window, all other windows containing the same document reflect those 
changes.    When you open a new window, it becomes the active window and is displayed on top of all 
other open windows.



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion.



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)
Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)
Use this command to arrange multiple opened windows side by side.



Arrange Icons command (Window menu)
Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)
The RichImage Mini-Viewer displays a list of currently open document windows at the bottom of the 
Window menu.    A check mark appears in front of the document name of the active window.    Choose a 
document from this list to make its window active.



Using Help command (Help menu)
Use this command to display help information about using Help.    This tutorial shows and explains the 
help system.



Contents command (Help menu)
Use this command to display help information about the RichImage Mini-Viewer.    This will open the help 
contents screen where you can find more help on a specific topic.

As you look through Help, you can return to the Contents screen by clicking the Contents button in the 
Help window.

Shortcut
Key: F1



About command (Help menu)
Use this command or button to display the copyright notice and version dialog box for the RichImage 
Mini-Viewer.



Context Help command
Use the Context Help command to obtain help on some portion of the RichImage Mini-Viewer.    When 
you choose Context Help, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Mini-Viewer window, such as a menu item.    The Help topic will be shown for the item 
you clicked.

Shortcut
Keys: SHIFT+F1



Title bar

The title bar is located along the top of a window.    It contains the name of the application (RichImage) 
and the name of the document (sample.rch).

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

The title bar may contain the following elements

· Name of the application.

· Name of the document.

Maximize button.

Minimize button.

Restore button.

Application Control button
Contains Maximize, Minimize, Restore, 
Size and Move commands.



Scroll bars
Scroll bars are displayed at the right and bottom edges of the document window.    The scroll boxes inside
the scroll bars indicate your vertical and horizontal location in the document.    Use the mouse with the 
scroll bar to move to other parts of the document.

The vertical scroll bar is located along the right side of the document window.
· Vertical scroll bars move up or down the current page, as well as to different pages.
· As you scroll up or down the document, the Page Number is shown in the Status bar Page area.

The horizontal scroll bar is located along the bottom of the document window.
· Horizontal scroll bars move left or right across the document and can show different pages in multiple 

page views.

Tip To jump to a specific page number, drag the vertical scroll boxes until that page number is shown 
in the Status bar Page area.



Size command (Control menu)
Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcuts
Mouse: Drag the title bar at the top of the window.
Keys: CTRL+F7



Minimize command (Control menu)
Use this command or button to reduce the selected window to an icon.

When you minimize a Document window, the Document icon is placed in the RichImage Mini-Viewer 
window.    Minimizing the RichImage Mini-Viewer window places the Mini-Viewer icon on the background 
screen.

Shortcuts
Mouse: Click the minimize icon .
Keys: ALT+F9



Maximize command (Control menu)
Use this command or button to enlarge the active window to fill the available space.

Shortcuts
Mouse: Click the maximize icon , or double-click the title bar.

Keys: CTRL+F10 enlarges a document window.



Restore command (Control menu)
Use this command or button to return the active window to its size and position before you chose the 
Maximize or Minimize command.

Shortcut
Mouse: Click the restore icon , or double-click the title bar.



Next Window command (Control menu)
Use this command to switch to the next open document window.    The RichImage Mini-Viewer determines
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (Control menu)
Use this command to switch to the previous open document window.    The RichImage Mini-Viewer 
determines which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menu)
Use this command to close the active window or dialog box.    Double-clicking a Control-menu box is the 
same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the File menu 
Close command.

Shortcuts
Mouse:  double click the close icon on the title bar.

Keys: CTRL+F4 closes a document window
ALT+F4 closes the RichImage Mini-Viewer window



Switch to command (Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



RichImage Mini-Viewer Document Workspace
This is the RichImage Mini-Viewer document area for viewing RichImage files.    The Mini-Viewer can: 
zoom, navigate, print, extract and embed RichImage documents.

Open a RichImage document with the File menu Open command.

For an overview of the RichImage Mini-Viewer, see the Contents screen.



RichImage Document
This is a RichImage document.    The RichImage Mini-Viewer can: zoom, navigate, print, extract and 
embed RichImage documents.

See also

Context Help command 



No Help Available
No help is available for this topic or window area.



Using RichImage Mini-Viewer
Zoom 
Show more or less detail and control 
the relative size of the document.

Page Views 
Control the number of pages 
displayed in the document window.



Using Zoom
Use zoom commands to change the view on the current document to show more or less detail as well as 
the overall scale.    You can change the zoom level by using the appropriate zoom option on the menu bar.

To show more detail and enlarge an area of the document, you want to Zoom In or use a larger zoom 
factor.    To show less detail and fit more of the document into the viewing area, you want to Zoom Out or 
use a smaller zoom factor.    The RichImage Mini-Viewer can zoom in 3000 percent of the original size, or 
zoom out to show 7 percent of the original document.

See also
Zoom In command

Zoom Out command

Zoom command



Using Page Views
The RichImage Mini-Viewer can display up to three pages across in one main document window.    Use 
the Menu Bar to select the number of pages to display.    The number of pages displayed is toggled from 
either one, two or three at any time for the document.    To show all of the available pages in any page 
mode, zoom to the appropriate level to view the selected number of pages.

See also
One Page command

Two Pages command

Three Pages command



Menu bar commands
The menu bar is located below the title bar and contains RichImage Mini-Viewer commands.    You can 
use the mouse or the keyboard to access menu items.    Using the mouse, click on a menu item.    Using 
the keyboard, press the ALT key and the underlined first letter of the menu item that you want.    Then use 
the arrow keys to navigate to menu commands.

Select a menu item command for more Help
File menu
Open Open an existing document.
Close Close an opened document.
Extract files... Split an embedded viewer document into components.
Create Viewer...Create and embedded viewer document.
Information Document creation and other information.
Print Print the current document.
Print Setup Select a printer and printer connection.
Exit Exit the RichImage Mini-Viewer.

Tools menu
Hand Use the Hand page positioning tool.
Zoom In Use the Zoom In tool.
Zoom Out Use the Zoom Out tool.

View menu
Zoom Change the zoom level.
Reduce Page Reduce the zoom level.
Enlarge Page Increase the zoom level.
Go To Page Jump to a specific page in the document.
First Page Jump to the first page.
Previous Page Jump to the previous page.
Next Page Jump to the next page.
Last Page Jump to the last page.
One Page Show one page across in document window.
Two Pages Show two pages across.
Three Pages Show three pages across.

Window menu
New Window Create a new window that views the same document.
Cascade Arrange windows in an overlapped fashion.
Tile Arrange windows in non-overlapped tiles.
Arrange Icons Arrange icons of closed windows.
1, 2, ... Go to specified window.

Help menu
Contents Offer you the contents of topics on which you can get help.
Using Help Provide general instructions on using help.
About Display the version number of the Mini-Viewer.



About RichImage Mini-Viewer Help
Welcome to the RichImage Mini-Viewer help system.    Use help to learn how to use the Mini-Viewers 
commands and features.

Help
· This help system has buttons that you press to see more about a different topic.    Here is a button 

that you can press:
Notice how the normal Arrow cursor 
changes to a Hand cursor, showing you 
that something special will happen.

· Help also has buttons that you can navigate with.    They are located along the top of this window.    
The Contents button moves you to the contents screen.    Use the Search button to find help on 
specific topics.    Use the Back button to jump to the last help screen that you were at.

RichImage and RichView
· RichImage is the file format for RichView and RichImage Mini-Viewer documents.    RichView and the 

Mini-Viewer can only open this document type.    These documents were printed on a computer 
through the RichImage Printer Driver to the file that you view.    A RichImage file recreates the original 
document image as precisely as possible.

· You can add special functionality to any RichImage document using RichView.    Annotations, Links 
and Layers are easily added and saved to form a new document.    When you share your new file with
people, your special changes (Annotations, Links, Layers,...) can be seen and used by those who 
view your document.

See also
Contents screen

Context Help command



You pressed the Button!
Buttons like this one are the same as Solid Green Underlined text.    They jump you to new topics to show 
you more information.    Press this dashed underlined text to see what broken underlined text does.



This time you pressed the Underlined Text!
This window is used to show you more help about the underlined words.    Underlined words do not take 
you to new topics, they just explain something.

· Click the mouse to make this box go away.



Zoom command (View menu)
The Zoom command allows you to change the current zoom level by using the Zoom dialog box.

Shortcut
Keys: Ctrl+Z



Zoom Level
Enter a new zoom level to use with the document.    Entering a larger zoom number than the current zoom
level will zoom in on the document,    showing more detail.    Entering a smaller zoom number will zoom 
out of the document, showing more of document in less detail.

· Valid zoom numbers are from 7 to 3000 percent.



Enlarge Page command (View menu)
The enlarge page command changes the zoom level to the next greater standard zoom level.    This 
shows the document in more detail.

Shortcut
Key: +



Reduce Page command (View menu)
The reduce page command changes the zoom level to the next smaller standard zoom level.    This 
shows the document in less detail.

Shortcut
Key: -



Go To Page command (Edit menu)
The Go To Page command allows you to jump to a specific page in the document by using the Go To 
Page dialog box.

Shortcut
Keys: Ctrl+G



Page Number
Enter the page that you would like to go to.



Information command (File menu)
The information command displays source information about the document.

Select an information area for more help:



Version
Displays the RichImage document file version number.



Platform
The platform the author used to create the document.



File
The name of the RichImage document.



Size
The file size of the document.



Pages

Total number of pages in the document.



Application
The application that the author originally used to print the document.



Resolution
The resolution of the document in dots per inch.



Author
The creator or person who originally created the document.



Company
The company of the author of the document.



Creation Date
The date when the document was first created.



Last Modified
The last date when the document was saved or modified.



Distributing RichImage
RichImage is the file format for RichView and RichImage Mini-Viewer documents.    Only RichImage 
documents and embedded Mini-Viewer documents may be distributed.    Documents may be exchanged 
across platforms.    RichImage currently supports IBM and Apple personal computer platforms.

RichImage Viewer
RichView or the RichImage Mini-Viewer are required to view documents in RichImage format.    You may 
not distribute RICHVIEW.EXE or any support files.    The Full-Viewer (RichView) is licensed to a single 
user and is not sharable.    To allow non-licensed users to view RichImage documents, you can either 
embed a Mini-Viewer using the RichView save option, the Mini-Viewer create viewer command, or 
include the RICHMINI.EXE Mini-Viewer along with your document.

RichImage Printer Driver
The Printer Driver is required to make RichImage documents.    You may not distribute RICHIMG.DRV or 
any support files.    The printer driver is used by the original author of the document to create normal 
document files as well as embedded viewer documents.    Print to the RichImage printer driver from your 
application to create a RichImage document on disk.

Embedded Viewer Documents
Viewer embedding can be done in RichView, the Mini-Viewer, or in the RichImage Printer Driver.    
Embedded viewer documents may be distributed.    If you embed the viewer in a RichImage document, it 
becomes a self-contained program and document that can be viewed by people who do not own 
RichImage.    An embedded viewer will allow someone to view the document and perform limited 
RichView functions.

Crandell    Group, Inc.    ·    125 East Victoria Street    ·    Santa Barbara, CA    93101.
Tel: 805-962-1199    ·    Fax: 805-962-5650



OK
Use all of the changes and settings and close the dialog box.



Cancel
Cancel any changes and close the dialog box.



Help
Display this help system.



Network...
Connect to a network location, assigning it a new drive letter.



Scroll bar (Document window)
The document window scroll bar is used to show different parts of the screen at the current zoom level.

The vertical scroll bar is located along the right side of the document window.
· Vertical scroll bars move up or down the current page, as well as to different pages.

The horizontal scroll bar is located along the bottom of the document window.
· Horizontal scroll bars move left or right across the document and can show different pages in multiple 

page views.



Title bar
The title bar is located along the top of a window.    It contains the name of the application (RichImage) 
and the name of the document (technote.rch).

See also
Using the Title bar



Menu bar
The menu bar contains File, Edit, View, Window and Help menu items.    You can use the mouse or the 
keyboard to access menu items.

· Using the mouse, click on a menu item.

· Using the keyboard, press the ALT key and the underlined letter for that menu item;    ALT+F opens 
the File menu.

See also
Menu bar commands



JUNK ENDING...
This is not really a Topic!!!

 




